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Speed-reading experts estimate that the
average reader can absorb about 250
words per minute. They promote tech-
niques that allegedly boost that rate to
nearly 1,000 words per minute. Unfor-
tunately, some folks may expect similar
speeds for technical editing. After all,
isn’t editing like reading? If so, a 20-
page white paper should be edited in 20
minutes — or less.

But editing must surely take longer than
reading. Maybe it takes, say, five times
longer. That would mean editing about
12 pages per hour. Sounds good. Just
read the page five times, and out pop
the edits.

Actually, that heuristic may hold true
for a simple edit, but substantive editing
takes more time — 15 to 60 minutes per
page, some experts say. So, how long
can editing take? I suppose it’s safe to
say that editing shouldn’t take longer
than writing. (Not counting wordsmiths
who write faster than human beings can
read.)

In the table below, I present some prac-
titioners’ numerical benchmarks for es-
timating editing time. These speeds
were collected from an informal survey
of the STC’s TE SIG online discussion
group and some simple Web searches.

Note that in the table, I’ve converted
everyone’s estimates into words per
hour (WPH) instead of pages per hour.

Here are my reasons:

• Word counts are universally ac-
cepted in this world of diverse
printed and on-screen page sizes.

• Word counts may be more persua-
sive to clients in substantiating
longer-than-expected schedule esti-
mates.

Benchmark Editing Speeds (WPH) at Three Levels of Detail
Estimator Heavy Medium Light

Jean Hollis Webera 500–1,000 2,000–3,000 4,000–5,000

Amy Einsohnb 250–500 500–750 500–1,000

1,000–1,750 1,000–1,500 1,500–2,250

Jody Roesc 1,000 1,500 3,000

Gary Conroyc 500–1,000 2,000 4,000

W. Thomas Wolfed 416 1,250 1,666

Mary Jo Davidc 750–1,250

Richard Ketrone 500–1,000

Joanna Williamsc 5,000

Notes:
a Original estimates given in terms of 500 words per page.
b Original estimates found in The Copyeditor’s Handbook (see “Resources” on page 3). Top row
assumes difficult text; second row assumes standard text.
c Original estimates cited in pages per hour (250 words per page assumed).
d Original estimates given in pages per day (six hours per day assumed).
e Original estimate cited 15 to 30 minutes per page (250 words per page assumed).
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Do you use the serial comma before the conjunction in a simple series?

• Yes, I use the serial comma. (For example: Jenny has dogs, cats, and gerbils.)
• No, I don’t use the serial comma.  (For example: Don’t hire just any Tom, Dick

or Harry.)

Cast your vote and submit your comments on our Web site (www.stcsig.org/te).
We’ll report the results in our next issue.
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As a technical editor, you’d be wise to
create a style guide for your writing
group. A style guide is a time-saving re-
source that documents the guidelines for
punctuation, capitalization, spelling and
usage. Just those four categories may
seem overwhelming at first — so much
to be covered! But remember that a style
guide is a living document; it’s con-
stantly updated, never truly finished.

To begin, decide if it makes sense to
create your own style guide or adopt an
existing one. Some technical editors
adopt the Microsoft Manual of Style for
Technical Publications (second edition)
as their standard, and then they create a
list of exceptions to that guide’s rules.
The downside here is that people must
check two places for answers. If you
decide to use this method, keep your list
reasonably short. This article assumes
you’re creating your own guide.

Planning the Style Guide

As you plan the guide, research and an-
swer these questions:

• Who’s your audience? Freelance edi-
tors? Writers in your group? Others in
the company who write about the
products?

• Does your audience need examples for
the style rules you set? Examples can
drive home a style rule for readers.

• How will the style guide be produced?
As a help file? On your company’s
intranet? As printed pages?

• How will you update the guide and get
those updates to the guide’s users?

• How will people access the infor-
mation? Index? Search mecha-
nism? (Don’t rely solely on a table
of contents.)

• Should people read the entire style
guide, or should they dip into it
only for specific answers? If you
choose the latter, consider organiz-
ing your guide as an A-Z refer-
ence, the traditional organization
for an in-house style guide.

• Does your company have people
with vested interests in some style
decisions? Consider meeting with
them about controversial style rules
or usage decisions.

• How does the localization of your
technical documents constrain your
style decisions?

Writing the Style Guide

As you begin writing the guide, docu-
ment the standard topics that most style
guides contain (“Capitalization,” “Com-
mas,” “Bullet Lists,” and so on). Keep
your writing style extremely concise,
and use subheads to organize the infor-
mation for readers.

Use your style guide as a place to collect
the correct spelling of feature names in
your products. Is it “InfoCenter”? Or
“infoCenter”? Or “Info Center”? These
entries are quick to write and save writ-
ers a lot of aggravation.

Early in the development of the style
guide, create entries about your group’s
biggest writing bugaboos. What do you
correct over and over as you edit? For
example, your writers may document
procedures using inconsistent wording.
Create an entry called “Standard Word-
ing in Procedures” that defines wording
for menus, dialog boxes, and so on.
Here’s an example from such an entry:

Don’t forget to ask the potential users of
your style guide what they want in the
guide. And provide a mechanism for get-
ting feedback to you about the guide’s
entries (ones that are there, and ones that
may be missing).

Build the style guide during your down-
time, and add rules for troublesome
terms during your crunch time. Writing a
style guide may seem like a daunting
task. But remember that each entry you
add is a question answered for somebody
and, quite possibly, time saved for you.

Ellen Perry
Ellen Perry is a lead technical editor at
Autodesk, Inc. She coordinates the editing and
indexing of the end-user and developer docu-
mentation for AutoCAD, a design and draft-
ing program for architects and engineers.

Standard Wording for Menus
Identify the menu at the beginning of the
step with the phrase on the _____ menu;
use the verb click for items on a menu.

Right
• On the Tools menu, click Options.
• On the View menu, click Toolbars

-> Standard.
• On the shortcut menu, click Select

All.

Wrong
• Click Options on the Tools menu.
• From the View menu, choose Toolbars

-> Standard.
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• Word counts support the editor’s
focus on words, not pages.

• Word counts of selections or full
documents are easily run from
modern word processors — that’s
how I cut this article down from
2,996 words to 1,000!

In the table, the levels of editing —
heavy, medium and light — represent a
spectrum of editorial interventions,
where a heavy edit involves the most
rewriting and content-level corrections
and a light edit involves only the most
superficial proofing of glaring errors.
The key is to interpret these intention-
ally vague categories in terms of your
own skills and text. For your reference,
the estimators mentioned a variety of
technical document types, including
online help systems, manuals, white
papers, proposals, Web pages, release
notes, installation guides, Web-based
and paper-based training materials,
post-project reviews, marketing copy,
requirements, and needs analyses.

With these benchmarks in mind, the
best way to estimate editing time is to
do the following:

• Calculate a rough time estimate
based on a word count and your
prescription for a heavy, medium or
light edit; use one of the benchmark
ranges as a starting point.

• Start editing, keeping track of the
number of words you mill per hour
or sitting.

• Compare your measurements
against the benchmarks.

• Discover through trial and error
your personal word processing
speed — the number of words your
brain can mill in an hour.

Your personal word processing speed is
the uncertain factor in our formula —
complementing the discrete pile of
words you are given to edit. That speed
is subject to all the functions that make
editing slower than speed-reading:

checking for rule violations (spelling,
punctuation, grammar), consistency,
parallel construction, verb strength, ac-
curacy, logic, persuasiveness, rhythm,
tone, appropriateness, flow and many
other nuances.

Thinking about personal speed means
acknowledging a universal limitation:
You can think fast, but you can’t think
faster. (For this insight, I thank the
Oracle character in Tom DeMarco’s
The Deadline: A Novel on Project
Management.) Coffee may help, but
when you edit, the tyrannical ticking of
the clock cannot make your brain pro-
cess words at a quicker rate. As Mary Jo
David of Write Away Enterprises, based
in Plymouth, Mich., wrote to me, “No
matter what I do, my editing ‘average’
always seems to be anywhere from
three to five pages an hour.” I’m the
same way — my mill is often set in
heavy-editing mode.

The trick to estimating is to identify your
brain’s preferred rate of word processing
— not the optimum, two-espresso brain
speed, but something more comfortable
and sustainable. Just as you are unique,
so must your estimates be unique to your
skills and the constraints imposed on
you. Once you’ve determined your per-
sonal word processing speed, you’ll find
it easier to schedule your work when the
ideal amount of time your estimate calls
for is compressed by an external party’s
deadline. Shifting out of heavy-editing
mode should become easier for you the
more you’ve measured myself in the
other modes.

I hope this brief article contributes to
your skill at predicting the future.
Please e-mail me with your insights at
david@wordsupply.com. I’m just be-
ginning to study and write on the topic.
At right, to compensate for everything I
haven’t mentioned, I refer you to some
books and online resources. I especially
recommend the helpful articles that
Robin Cormier and Jean Hollis Weber

have posted online — read these clas-
sics for a much more logical approach
to the subject — and Michelle Corbin’s
intriguingly useful Java-based calcula-
tor for editorial times.

David W. McClintock
Based in New York, David edits and writes
through his firm, Wordsupply.com. By day,
he is a senior editor for Dorset House Pub-
lishing. He sends heartfelt thanks to all the
TE SIG members who e-mailed him their
insights.
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In our March issue, we asked for your style of referring to the computer connection
term online. Here’s how you voted:

• online — 86% (176 votes)
• on line  — 1%  (2 votes)
• on-line — 10% (19 votes)
• I use another form — 4% (7 votes)

What You Said
• “ ‘Online’ would be used in this form as a modifier (online banking) or location

indicator (I found the article online) in a computer context. However, a process
or facility would be brought ‘on line.’ ”

• “Online is the preference in Microsoft’s style manual for technical publications,
which seems to be the most up-to-date reference for computer terms.”

• “If your style is to spell ‘e-mail’ with a hyphen, I think you need to spell ‘on-
line’ with a hyphen also. But the evolution of the spelling of a word usually goes
from two words to a hyphen to a single word (to day, to-day, today), so perhaps
the word ‘on-line’ has evolved to the point where it has become one word, but
‘e-mail’ is not quite so evolved!”

• “I tend to use online as an adjective and on line as a prep. phrase.”

For other comments, see the “Corrigo Supplement” section of the TE SIG Web site
(www.stcsig.org/te/newsletter/supplement).
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The TE SIG’s online discussion group officially got started on March 12, 2002, and we hope it will serve as a forum for infor-
mation exchange, professional support and interaction among the TE SIG members.

Since we sent the invitation e-mail to the TE SIG members, more than 340 interested individuals have subscribed to the list and
participated in many interesting discussions, including those on the following topics:

• Charging for heuristic evaluations
• Estimating editing time
• Using editing marks
• Developing an editing portfolio

We hope these quality discussions will continue. Participating in a group like this gives us all a chance to expand our editing
knowledge and share information with others in our field. Some ideas for future discussion topics include:

• What are your thoughts on editing Web content, multimedia, digital video, etc., vs. editing paper documents?
• Where should editors come into the process of developing/designing technical documentation?
• How much technical information do editors need to understand to do a thorough content edit?
• What are your opinions of online editing tools?

So, if you’ve already signed up for the TE SIG’s discussion group, continue to ask questions of your fellow editors! Submit is-
sues and concerns, and find out what others have to say. If you haven’t signed up yet, go to http://lists.stc.org/cgi-bin/
lyris.pl?enter=stctesig-L and follow the instructions to become a participating member. Sign-up information, including infor-
mation on posting messages and modifying your settings, is also available on the TE SIG Web site at www.stcsig.org/te.

If you have any problems with or questions about the discussion group, contact Katie Lerfald at kathryn.lerfald@unisys.com.

Katie Lerfald
Katie Lerfald is a technical editor at Unisys Corporation, where she edits computer hardware and software manuals, and online help files.
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Want more information on editing top-
ics? Look here.

• www.techcomm-online.org
• www.buzzwhack.com
• ccc .commnet .edu/grammar /

index.htm

If you have a favorite link, let us know.
E-mail  j9riter@hotmail.com.

In Our Next Issue

• Tips for finding technical
writing and editing jobs

• Starting out as a freelancer?
We’ll share our ideas on
getting started.

• Your article could appear
here. Send it to us now.


